Installation Guide
Version 2018.2.1
# Table of Contents

**Move2018.2.1 Software and Supporting Documentation** ......................................................... 3  
Move2018.2.1 Software .................................................................................................................. 3  
Move2018.2.1 Release Documentation ......................................................................................... 3  

**System Requirements** ......................................................................................................... 4  
Operating Systems .................................................................................................................... 4  
Graphics Card ............................................................................................................................. 4  
Hardware .................................................................................................................................. 5  

**Installing Move** .................................................................................................................... 6  
Installing on Windows ................................................................................................................. 6  
Installing on Linux ..................................................................................................................... 8  
Use /SILENT or /VERYSILENT Options When Scripting ......................................................... 10  
Use Environment Variable (use MVELD_LICENSE_FILE) .......................................................... 10  

**Move Link for Petrel v2018.2.1** ......................................................................................... 12  
System Requirements ............................................................................................................... 12  
Installation ............................................................................................................................... 12  

**Move Link for OpenWorks R5000** .................................................................................... 13  
Installation (client) .................................................................................................................... 13  

**Installing Move Knowledge Base** ....................................................................................... 14  
Installing on Windows ............................................................................................................... 14  
Installing on Linux .................................................................................................................... 14  

**Contacting Petroleum Experts** ........................................................................................... 17
MOVE2018.2.1 SOFTWARE AND SUPPORTING DOCUMENTATION

Move2018.2.1 Software

Move2018.2.1 Software Installers for Move and Knowledge Base

<table>
<thead>
<tr>
<th>Installers</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move2018.2.1/Windows64</td>
<td>Installers for Windows (64-bit)</td>
</tr>
<tr>
<td>Move2018.2.1/Linux64</td>
<td>Archive for Linux (64-bit)</td>
</tr>
</tbody>
</table>

License Manager Software

<table>
<thead>
<tr>
<th>Installers</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>LicenseManager/FLEXnet11.14/Windows64</td>
<td>License Manager for Windows (64-bit)</td>
</tr>
<tr>
<td>LicenseManager/FLEXnet11.14/Linux64</td>
<td>License Manager for Linux (64-bit)</td>
</tr>
<tr>
<td>LicenseManager/FLEXnet11.14/docs</td>
<td>License Manager Documentation</td>
</tr>
</tbody>
</table>

Move Link for Petrel Software Installers

<table>
<thead>
<tr>
<th>Installers</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>MoveLinkforPetrel/Petrel 2016</td>
<td>MSI and PIP Installers for Petrel 2016</td>
</tr>
<tr>
<td>MoveLinkforPetrel/Petrel 2017</td>
<td>MSI and PIP Installers for Petrel 2017</td>
</tr>
<tr>
<td>MoveLinkforPetrel/Petrel 2018</td>
<td>MSI and PIP Installers for Petrel 2018</td>
</tr>
</tbody>
</table>

Move2018.2.1 Release Documentation

The following documents, Tutorials, and Knowledge Base are provided with Move2018.2.1

The Knowledge Base resource contains all the Move Help Pages, Tutorials, Monthly Features and release documentation presented in a single, offline, searchable entity, independent of Move.

- Move2018.2.1 Release Notes PDF
- Move2018.2.1 Installation Guide PDF
- Move2018.2.1 Licensing Guide PDF
- Move2018.2.1 Tutorials
- Move2018.2.1 Tutorial Data Files
- Move2018.2.1 Knowledge Base
SYSTEM REQUIREMENTS

Operating Systems

Please check to ensure you have at least the minimum specification before installing:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Windows 7 or Windows 8 or Windows 10 (all 64-bit only)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Windows requires .NET Framework 4.6. or higher.</td>
</tr>
<tr>
<td>Linux</td>
<td>Linux Red Hat Enterprise 6 or 7 (all 64-bit only).</td>
</tr>
<tr>
<td></td>
<td>Move may run on other distributions of Linux however these have not been tested. For optimal video performance with OpenGL when using an NVIDIA video card under Linux, it is recommended that you use the accelerated drivers provided by NVIDIA on their website <a href="http://www.nvidia.com">www.nvidia.com</a>.</td>
</tr>
<tr>
<td>Microsoft Azure</td>
<td>For Move to function effectively then it will need an Azure N-Series specification or similar, NC, NCv2, NCv3, and ND, or NV: see here.</td>
</tr>
<tr>
<td></td>
<td>To take advantage of the GPU capabilities of Azure N-series VMs running Windows, NVIDIA GPU drivers must be installed. The NVIDIA GPU Driver Extension installs appropriate NVIDIA CUDA or GRID drivers on an N-series see here.</td>
</tr>
</tbody>
</table>

Graphics Card

Move is a graphics intensive application and takes advantage of modern hardware GPUs in order to speed up 3D rendering. The more memory on the graphics card the better Move will handle larger 3D/2D Seismic files, DEMs and Image overlays.

Graphics Card minimum requirements (Notebook or Workstation)

- Minimum of 4GB of RAM
- Graphics card drivers fully up to date
- Run pixel shader 2 or later
- Be OpenGL compatible

Notebook Graphics Card mid-range:

- NVIDIA with 4-6 GB RAM e.g. Quadro M4000M, M22000, P2000, P3000, P3200

Notebook Graphics Card high-end

- NVIDIA with 8-16 GB RAM e.g. Quadro P/M5000, P/M6000,M5500, P4000, P5000, P4200, P5200

Workstation Graphics Card mid-range

- NVIDIA with 4-8 GB RAM eg. Quadro M2000, M4000, M5000, P1000, P2000, P4000
**Workstation Graphics Card high-end**

- NVIDIA with 12-32 GB RAM e.g. Quadro K6000, M6000, P5000, P6000, GP100, GV100

**Hardware**

The following list is provided as a general guide only. If your system configuration is different and you are unsure of its capability then please email us: edinburgh@petex.com with your system details for further information. The hardware requirements greatly depend on the size of data sets you are using. If you are working with large data sets and utilising Move applications simultaneously then we would strongly suggest the following recommendations.

### Workstation/Desktop

For example, Dell Precision 5820, 7820, 7920

<table>
<thead>
<tr>
<th>Specification</th>
<th>Recommended Minimum</th>
<th>Recommended Ideal</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel i5 quad-core</td>
<td>Intel i7 /Xeon E5 4C/6C/8C/12C</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB</td>
<td>16-128 GB+</td>
</tr>
</tbody>
</table>

### Laptop/Notebook

For example Dell Precision 5 5530 15”, 7530 15”, 7730 17”

<table>
<thead>
<tr>
<th>Specification</th>
<th>Recommended Minimum</th>
<th>Recommended Ideal</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>Intel i5 4C</td>
<td>Intel i7/i9 4C/6C</td>
</tr>
<tr>
<td>Memory</td>
<td>8 GB</td>
<td>8-64 GB+</td>
</tr>
</tbody>
</table>

### Screen/Monitor

- Minimum screen resolution is a single monitor/screen with 1920 x 1080 pixels (full HD 1080p)
- Move is a graphics intensive application supporting multiple simultaneous views of your data model, and we recommend as much screen space as you can afford in order to maximise your experience and attention to detail.
- Move will support dual monitors which are recommended at 30” in size and above.
INSTALLING MOVE

Windows and Linux have different installation instructions. Please refer to the appropriate section below.

Installing on Windows

It is recommend that you should be a power/administrator user on Windows to install or with UAC elevated to administrator to install on Windows.


- **Desktop** - .NET Framework 4.6 comes pre-installed with Windows 10 first version and all versions thereafter. Can be downloaded for Windows 8.1, 8 and 7.

To begin the installation process you must browse to the installer file, for example:

:\Move2018.2.1\Windows64\move_2018.2.1_windows_64-bit.exe

**Installation Folder**

Select the folder in which you wish to install Move. You may select your own location by clicking **Choose** or by typing the explicit location in the input box. By default it is:

C:\Program Files\Petroleum Experts\Move2018.2.1
Uninstalling Move on Windows

Please use the Control Panel to uninstall Move.

Using Windows Remote Desktop

When connecting to a remote system using Microsoft’s Remote Desktop Services you may experience issues when using larger models. This is due to limitations with the software OpenGL driver that is used when using the remote connection. There are several ways to work around such issues:

Use another remote display application that uses the hardware capabilities of the host machine.

Start Move on the host machine BEFORE connecting to it. This requires physical access to the host system.

Use the alternate software OpenGL drivers provided with Move. These are located in the bin/mesa3d folder inside the location where Move was installed. When Move senses that it is running remotely then it will prompt the user that the software drivers are being copied into the bin folder and being utilised. See notes below:

Cloud and Virtual machine usage additional notes:

Clients can use Move via remote or cloud solutions or technologies e.g. HP RGS, VMware vSphere, Citrix Xen, Microsoft Azure, OpenText Exceed, or Windows Server 2016 DDA/Remote FX.

You must ensure for the best experience that the remote machine or technology has dedicated or a virtual GPU resource that will enable 3D graphics, OpenGL, and GPU capability. The Azure Cloud (N-Series), or Windows Server 2016 DDA/Remote FX capability both provide GPU solutions.

You can run Move on the Windows Server environment using basic RDS/RDP technology, however Move will fall-back to “software” rendering for OpenGL or GPU code. This is satisfactory to a degree, however will be much slower that “native” or managed “virtual/cloud” solutions, with 2D or 3D Seismic rendering being especially very limited.

The number of choices for deployment to the cloud or a virtual environment is really client preference, and we cannot recommend one solution over another. We also cannot test Move in all end-user virtual environments due to sheer number of possible software and hardware configurations, however we can assist with any problems you may come across when the environment or solution is being tested prior to production.

3D PDF Animations

On machines without Adobe Flash Player installed, the 2D animation controls in the 3D PDF output fail to function. Flash is NOT required for viewing the 3D content files, only the 2D Section Animations. Install Flash Player software to resolve this issue.

The Acrobat Player error message links to here:

Installing on Linux

We recommend you should have root permission or be the root user on Linux to install.

Installing Move on Linux is a straight forward process of extracting the software from the archive and running a script which will prompt for required input at the appropriate time.

The software can be installed anywhere, the following instructions assume it will be installed in /opt/MOVE.

---

Extracting the software

Move is bundled in compressed tar archive. To extract the software, follow these steps:

1. Go to destination directory:

   ```
   prompt# cd /opt
   prompt# mkdir -p MOVE
   prompt# cd MOVE
   ```

2. Copy tgz file:

   ```
   prompt# cp USB_Drive/Move2018.2.1/Linux64/move_2018.2.1_linux_64-bit.tgz .
   ```

3. Extract archive:

   ```
   prompt# tar zxf move_2018.2.1_linux_64-bit.tgz
   ```

This will create a Move2018.2.1 folder containing the software.

---

Running the setup scripts

You now need to run the setup script which will complete the installation process.

4. Go to bin directory:

   ```
   prompt# cd /opt/MOVE/Move2018.2.1/bin
   ```

5. Run Move set-up script:

   ```
   prompt# ./setup.sh
   ```

   Do you wish to install Move in '/opt/MOVE/Move2018.2.1/bin' [Y/n]?

   Do accept the terms of the license agreement [Y/n/v]?

6. As shown above, you will be prompted for various information. The default answer is shown in upper case; press Return to accept it. Otherwise, type y or n and click Return to accept it. You will be asked to:
   - Confirm location
   - Accept the license agreement (pressing v will display the license agreement).

7. Once the setup script completes, it will display the installation log containing any errors, saved in:

   ```
   /opt/MOVE/Move2018.2.1/bin/install.log
   ```
8. To start Move, please use the 'move' script generated during the installation (do not run the Move application directly).

```
prompt# /opt/MOVE/Move2018.2.1/bin/move
```

**Uninstalling Move on Linux**

Remove the entire installation directory using the following command:

```
prompt# /bin/rm -rf /opt/MOVE/Move2018.2.1
```
Installing Move via Mass Deployment Tools

When installing Move2018.2.1 via a deployment tool such as SCCM the following commands can be used to silently install Move removing the requirement for local user interaction.

C:\> install.exe /SILENT
C:\> install.exe /VERYSILENT
C:\> install.exe /VERYSILENT /COMPONENTS=“main”

Use /SILENT or /VERYSILENT Options When Scripting.

/SILENT, /VERYSILENT

Instructs Setup to be silent or very silent. When Setup is silent the wizard and the background window are not displayed but the installation progress window is. When a setup is very silent this installation progress window is not displayed. Everything else is normal so for example error messages during installation are displayed and the startup prompt is (if you haven't disabled it with DisableStartupPrompt or the /SP parameter).

If a restart is necessary and the /NORESTART command isn't used (see below) and Setup is silent, it will display a Reboot now? message box. If it’s very silent it will reboot without requiring permission.

/SUPPRESSMSGBOXES

Instructs Setup to suppress message boxes. Only effective when combined with '/SILENT' and '/VERYSILENT'.

The default response in situations where a choice offered is:

- Yes in a 'Keep newer file?' situation.
- No in a 'File exists, confirm overwrite.' situation.
- Abort in Abort/Retry situations.
- Cancel in Retry/Cancel situations.
- Yes (=restart) in a FinishedRestartMessage/UninstalledAndNeedsRestart situation.

5 message boxes are not suppressible:
- The About Setup message box.
- The Exit Setup? message box.
- The FileNotInDir2 message box displayed when Setup requires a new disk to be inserted and the disk was not found.
- Any (error) message box displayed before Setup (or Uninstall) could read the command line parameters.
- Any message box displayed by [Code] support function MsgBox.

Use Environment Variable (use MVELD_LICENSE_FILE)

Set from user/machine Windows registry or from the system/domain environment. Registry:

HKEY_CURRENT_USER\Software\FLEXlm License Manager\MVELD_LICENSE_FILE
Set this variable value to point to the license server. eg @hostname or port@hostname.

The port number is optional when the license server is running on default 27000 to 27XXX.

By default Move will look to the environment first for a license, removing the requirement for this to be set-up individually.
MOVE LINK FOR PETREL V2018.2.1

The Move Link for Petrel* provides a means for Petrel users to share and transfer data with Petroleum Experts Move product.

Once installed, the Link allows the Petrel user to specify objects within the input tree to send across to Move. Once in Move, it is then possible to perform model building, editing and analysis or utilise functionality within the modelling modules to perform restoration, validation, balancing, Fault Analysis, Stress Analysis, Geomechanical Modelling, Fracture Modelling and Fault Response Modelling on the transferred objects (if licenses for these modules have been purchased and are available).

*Mark of Schlumberger

System Requirements

Software

To use the Move Link for Petrel (version 2018.2.1), users are required to have a valid licence of:

- Petroleum Experts Move application 2018.2.1 (Move2018.2.1)
- Schlumberger’s Petrel seismic to simulation software version 2018.x, 2017.x, or 2016.x
- Move Link for Petrel version 2018.2.1 from Petroleum Experts. For clarification on compatibility please email edinburgh@petex.com.

Operating System

Petrel is a Windows only product and therefore the Move Link for Petrel will only be available where all products are running on Windows. See the Move system requirements and the Petrel software system requirements for details.

Installation

Move Link for Petrel can be either be installed using the Ocean Plugin Manager, or directly using the provided msi installer package files.

To install using the Plugin manager.

- Access the Ocean Plugin Manager... (when using the ribbon interface this is accessed via the File -> Options menu, and in the Classic User interface via the Help menu)
- Select Install plugin.
- Browse to the appropriate pip file on the installation disk( see table below ).
- Close down Petrel.
- When Petrel is restarted, the Move Link icon will be visible (If using the ribbon interface, this will be in a new MVE group in the Home tab, and when using the classic interface, as a tool button in the File Actions toolbar.

It is recommended that the plugin is installed using administrator privileges.

<table>
<thead>
<tr>
<th>Move Version</th>
<th>Petrel Version</th>
<th>Move Link for Petrel Version (via pip or msi)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move2018.2.1 (64-bit)</td>
<td>2018.x (64-bit)</td>
<td>MoveLink2018forPetrel2018.pip</td>
</tr>
<tr>
<td>Move2018.2.1 (64-bit)</td>
<td>2017.x (64-bit)</td>
<td>MoveLink2018forPetrel2017.pip</td>
</tr>
<tr>
<td>Move2018.2.1 (64-bit)</td>
<td>2016.x (64-bit)</td>
<td>MoveLink2018forPetrel2016.pip</td>
</tr>
</tbody>
</table>
**MOVE LINK FOR OPENWORKS R5000**

The Move Link for OpenWorks R5000 provides a means for Landmark OpenWorks users to share and transfer data with Petroleum Experts Move Application of the Move Suite.

The Link allows the Move user to directly import objects within an OpenWorks R5000 database via the input tree to send them across to Move. Once in Move, it is then possible to perform model building, editing and analysis or utilise functionality within the modelling modules to perform restoration, validation, balancing, Geomechanical Modelling, Fracture Modelling and Sediment Modelling on the transferred objects (if licenses for these modules have been purchased and are available).

### Software

To use the Move Link for OpenWorks R5000, users are required to have a licence of:

- Move Link for OpenWorks R5000 software from Petroleum Experts.
- Move software from version Move2018.2.1 from Petroleum Experts.
- Linux - Landmark OpenWorks software from version 5000.10.3 back.
- Windows - Landmark OpenWorks software from version 5000.10.3 back.
- Oracle software version 11g onwards.

For clarification on compatibility please email: edinburgh@petex.com.

### Operating System

Please check to ensure you have at least the minimum specification before installing:

- **Windows**
  - Microsoft Windows Windows 7 (64-bit).
- **Linux**
  - Linux Red Hat Enterprise 6 (64-bit).

### Installation (client)

The Link will work whether running Move from the same machine as OpenWorks is installed on or alternatively from a client machine on the network that can see the OpenWorks and Oracle installations.

Linux Move clients should ensure that Oracle and OpenWorks installations are on your PATH and LD_LIBRARY_PATH and visible on the network. Optionally on Linux you can install a local client of Oracle software.

Windows clients MUST install Oracle client and OpenWorks client software before you run Move. See the installation guides from these products for more information. Petroleum Experts do not supply Oracle or Landmark OpenWorks clients; these can be obtained as part of your own OpenWorks installation - contact your own local OpenWorks administrator. Some environment variables that need to be set or will help set-up include:

- OWHOME, OW_ORACLE_USER OW_HOME_DIR
INSTALLING MOVE KNOWLEDGE BASE

Windows and Linux have different installation instructions. Please refer to the appropriate section below.

Installing on Windows

It is recommend that you should be a power/administrator user on Windows to install or with UAC elevated to administrator to install on Windows Vista and Windows 7.

To begin the installation process you must browse to the installer file, for example:

USB-Drive:\Move2018.2.1\Windows64\Move_Knowledge_Base_2018.2.1_windows_64-bit.exe

![Setup - Move Knowledge Base](image)

**Installation Folder**

Select the folder in which you wish to install the Move Knowledge Base. You may select your own location by clicking Choose or by typing the explicit location in the input box. The recommended location is:

C:\Program Files\Petroleum Experts\Move2018.2.1 Knowledge Base

**Uninstalling Move Knowledge Base on Windows**

Please use the Control Panel to uninstall the Move Knowledge Base.

**Installing on Linux**

We recommend you should have root permission or be the root user on Linux to install.
Installing the Move Knowledge Base on Linux is a straightforward process of extracting the software from the archive and running a script which will prompt for required input at the appropriate time.

The software can be installed anywhere, the following instructions assume it will be installed in /opt/MOVE. If the /opt/MOVE directory has been created when installing Move2018.2.1 then the creation of the MVE directory in step 1 for extracting the software should be skipped.

### Extracting the software

Move is bundled in compressed tar archive. To extract the software, follow these steps:

1. Go to destination directory:
   
   ```
prompt# cd /opt
prompt# mkdir -p MOVE
prompt# cd MOVE
   ```

2. Copy tgz file:
   
   ```
prompt# cp USB_Drive/Move2018.2.1/Linux64/Move_Knowledge_Base_2018.2.1_linux_64-bit.tgz .
   ```

3. Extract archive:
   
   ```
prompt# tar zxf Move_Knowledge_Base_2018.2.1_linux_64-bit.tgz
   ```

### Running the setup scripts

1. Go to bin directory:
   
   ```
prompt# cd "/opt/MOVE/Move2018.2.1_Knowledge_Base/bin"
   ```

2. Run Move Knowledge Base set-up script:
   
   ```
prompt# ./setup.sh
   ```

   Do you wish to install Move Knowledge Base in "/opt/MOVE/Move2018.2.1_Knowledge_Base/bin" [Y/n]?

   Do accept the terms of the license agreement [Y/n/v]?

3. As shown above, you will be prompted for various information. The default answer is shown in upper case; press Return to accept it. Otherwise, type y or n and click Return to accept it. You will be prompted to:
   
   - Confirm the install location.
   - Accept the license agreement (pressing v will display the license agreement).

4. Once the setup script completes, it will display the installation log, saved in:

   "/opt/MOVE/Move2018.2.1_Knowledge_Base/bin/install.log"

Any errors will be saved in that file.
5. To start the Move Knowledge Base, please use the 'movekb' script generated during the installation (do not run the Move Knowledge Base application directly).

```
prompt# "/opt/MOVE/Move2018.2.1 Knowledge Base/bin/movekb"
```

### Uninstalling Move Knowledge Base on Linux

Remove the entire installation directory using the following command:

```
prompt# /bin/rm -rf "/opt/MOVE/Move2018.2.1 Knowledge Base"
```
CONTACTING PETROLEUM EXPERTS

Contact Details

Petroleum Experts Ltd.
Petex House, 10 Logie Mill
Edinburgh, EH7 4HG, UK

www.petex.com/products/move-suite/

T: +44 (0) 131 474 7030
F: +44 (0) 131 474 7031

<table>
<thead>
<tr>
<th>Support</th>
<th>Email address</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licensing &amp; Technical</td>
<td><a href="mailto:edinburgh@petex.com">edinburgh@petex.com</a></td>
</tr>
<tr>
<td>Geological</td>
<td><a href="mailto:edinburgh@petex.com">edinburgh@petex.com</a></td>
</tr>
<tr>
<td>Additional Licenses</td>
<td><a href="mailto:edinburgh@petex.com">edinburgh@petex.com</a></td>
</tr>
</tbody>
</table>